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Introducing InCAS

INCAS is a computer adaptive assessment for students aged 5 - 11 years old. INnCAS provides

a wealth of information at student, class and school level. It highlights students’ strengths and
weaknesses so that teachers can determine what students know and can do, which can inform
teacher planning and target setting. It provides age-equivalent scores and diagnostic information.

InCAS comprises of six modules and each student completes the assessment independently at a
computer by following audio instructions.

Each student needs access to a suitable device, keyboard, headphones and a mouse.
INCAS P2 (Age 5-6)

INCAS P3 (Age 6-7)

INCAS P4 (Age 7-8)

INCAS P5 (Age 8-9)

INCAS P6 (Age 9-10)

INCAS P7 (Age 10-11)

When to run InCAS assessments

INCAS assessments can be carried out at any point in the academic year. Your school can decide
what time is best for you, but your students should only do the assessment once. For consistency,
we would recommend administering the assessment at the same time each year.

INCAS assessments are available from the 1st August until the 31st August the following year.



Assessment modules, timings and overview

The six INCAS modules, including timings are below. As each student accesses the modules through
a unique password the modules can be taken over a period of a few days or even a few weeks. To
assist the students’ concentration, we recommend at least a break in between each module. This
may be play time or dinner time.

Module | Question Type and Task

Reading

20-25 mins

Potentially three question
types.

General Maths
20-25 mins
Four question types that

follow the sequence shown.

Mental Arithmetic
15-20 mins

Potentially four question
types.

Spelling

15-20 mins

Developed Ability (DA)
20-25mins

Two question types

Attitudes
5-10mins

Assesses the student’s
attitude to reading, maths
and school.

1. Word Recognition

A word will be spoken through the headset and the student will
use the mouse to select from the five options the word they have
heard.

2. Decoding

The student will hear a made up or unfamiliar word and from the
options select the ‘word’ they have heard.

3. Comprehension

Depending on how they have done on previous sections, not all
students will be presented with comprehension questions. If they
are, the student selects the missing word that makes the most
sense in the context of the sample passage.

1. Number Type 1 Counting, informal maths, place value, fractions.
2. Number Type 2 Sorting, patterns, problem solving, algebra

3. Measure, Shape and Space (MSS) including 2D and 3D shapes

4. Data handling.

1. Addition - Presented to all

2. Subtraction - Requires an addition age equivalent score greater
than 5

3. Multiplication - Requires a subtraction age equivalent score
greater than 7

4. Division - Requires a multiplication age equivalent score greater
than 8

Over the headset the student will hear a word and, using the
screen keypad, they have to spell the word they have just heard.

1. Picture Vocabulary
Students will hear and see the word and select the correct picture
match to the word from the options shown on screen.

2. Non Verbal Ability
Students are asked to find matching patterns in a larger pattern.

Students are asked their attitude to a series of questions. They use
the slide ruler to choose the most appropriate face option that
reflects their personal opinion.



Your main admin site - InCAS+

You can access all facilities for the INCAS assessments via the INnCAS+ secure website.
Go to www.cem.org and choose ‘Login’.

f v v @ in & Login

aCAMBRIDGE

WRIVERSITY FRESS & ASSESSMENT

Centre for Evaluation & Monitoring

Select InCAS from the options available and sign in with your username and password.

Select your secure login area

CEM SECURE u
InCAS n]
PIPS n
MidYIS / Yellis u
Alis / CEM IBE u

If you have misplaced your sign in details, please email: cem@cambridge.org. For security, these
details cannot be provided over the phone.

The Assessment Centre

This is the section of your INCAS+ account that you will use to upload your student’s details, run and
also to check the status of assessments. If you are using the non-web version, you can also return
your results files here.

When logged in to your account please select Administration > Assessment Centre

% CEM
-'f‘ Centre for Evaluation & Monitoring
! '

Administration Return Data ' Results/Analysis Downloads Help ‘

Home Page
Change Password

Logout

:
On the next screen, select the assessment year required and click ‘OK’

Y% CEM secure

Centre for Evaluation & Monitoring

Select Assessment

Use the list below to select the assessment that you would like to view.,
InCAS 2024-25 -
InCAS 2023-24
InCAS 2022-23
InCAS 2021-22
InCAS 2020-21
InCAS 2019-20 -

You will then be in the Assessment Centre for the assessment year selected.




Assessment Centre tabs explained

select assessments import manage pupil details password lists carry out assessments status reports return results

Welcome to the Assessment Centre

Please select the appropriate tab above.
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select assessments

manage pupil details

password lists

carry out assessments

status reports

return results

‘Select assessments’ allows you to change the assessment year you are viewing.

‘Import’ is the tab to use to upload your student details file

‘Manage pupil details” allows you to edit and add student and class details.

Each student has six three digit passwords, one for each module of the
assessment. Details can be found on this tab.

Here you can access the assessment shortcut and passkey to run your
assessment online or offline.

A status for each module of the assessment for every student registered is
displayed.
‘Completed’ - the student completed the assessment on the date listed.

‘Pending’ - the student did not start the web assessment, or you did not return
the completed assessment files for the Non-Web version.

‘In Progress’ means a student started the assessment but did not complete it.

Use this tab to return all results for the non-web version or to return locally saved
results files.



Technical requirements for running InCAS

We designed our online assessments to be delivered either through your web browser, when you
have a stable internet connection, or using a standalone downloadable non-web application if your
internet connection is low-speed or less reliable. You will require a sound-enabled computer to run
our INCAS assessment for both versions of the assessment.

For the web only version, you will typically be able to assess one student for every 1Mbps of line
speed. The assessment content will be downloaded at the beginning of each assessment. Results
are automatically returned after the assessments. The online assessments use HTML5.

For the non-web version of the assessments, all content is stored locally on your school’s server or
computer and results are returned manually to CEM after all assessments are complete.

Please visit our Technical Setup webpage at https://www.cem.org/general-technical-requirements
for the latest information relating to the following:

Recommended and supported operating systems

Recommended and supported browsers

Recommended and supported devices

Tips for smooth running of your assessments

Upload your CSV file of student details at least 24 hours in advance of your assessments.

2. Make sure that your CSV file of student details is saved as a CSV (Comma delimited) (*.csv) file.

3. For web assessments ensure all students have access to the passkey details on the day of the
assessment.

4. For non-web assessments be sure to upload your CSV file before downloading the assessment
software. Otherwise, the passwords may not work.

5. All students will have six passwords - one for each INCAS module. They will need the details to
enter the appropriate password at the beginning of each module.

6. Each student will need a headset in addition to the device on which they are taking the
assessment.

7. If students have open access to the InCAS software, they will be able to log themselves into the
software at any time and re-sit the assessments.

8. You may wish to run a trial assessment entering TEST as the first name and TEST as the
surname for the trial. Although the results will not appear in the reports, it will allow you to
see how the assessment works. You will need to complete the assessment in full to trial it
successfully.



Setting up the Assessment

Entering student details

If running the offline assessment, remember to import your students into the CEM Secure system
before you download the Non-Web assessment.

Whether you are running the offline or online version, the process of uploading the student details
to the system is the same.

The best way to enter the student information on to the INnCAS+ site is to import from a CSV
(Comma delimited) file. You will receive a CSV template as part of your welcome email. To download
a new CSV template visit our Help Centre here.

An example CSV template looks like this:

A B C D E F G
1 Surnarne DoB Gender Class Year Group UPN/student code
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Completing your CSV File

When completing your CSV file the column headers highlighted with a red asterisk below are
mandatory. You can leave out the other column headers if not required.

Column Header Description

* First name The first name by which the pupil is usually known

* Surname The surname by which the pupil is usually known

* DOB ddfmmiyyyy

* Gender M for male pupils or F for female pupits

* Class The class name can be up to 25 characters

* Year Group 1,2.3.4,5,6 (Eng. Aus) P2.P3,P4,PS5,P6,P7 (Scot, NI)

UPN/student code UPN or SCN (Unique Pupil Number or Scottish Candidate Number)
English as an Additional Language English as an Additional Language

Free School Meals Is the pupil entitled to Free School Meals?

Importing student details
To upload your completed CSV follow the steps below:
Enter the Assessment Centre and select Import

- manage pupil details m

2. Select the ‘Choose File' option and upload your CSV spreadsheet.

The following steps enable you to import your pupil details ready to run the assessment.
a. Select the file using the button below
Choose File | No file chosen

3. Select ‘Yes' in the section asking, ‘Does the file contain column headers?’
b. Does the file contain column headers?
® Yes O Ng

4. Click the ‘Upload’ button to upload the file.
c. Click to upload the file



5. The next page will ask you to map the column header names from your CSV file to the ones in
the drop-down menu options. You can choose ‘Ignore’ from the drop-down menu if you want
to exclude any of the columns from your CSV spreadsheet at this stage. ‘Next' to confirm the
details.

Import Pupil Details for InCAS

The followng steps enable you 10 Import your pupd detads ready 10 fun e Jusrument witaare
The left hand cobamn i the Labie belon shown the colurmn headers from your file The cchurrn are shown as Column 0 if no headengs were provided

a Pleare select the descriptions which beat match the content of your fils using each drop down list in the right hand

Header in the file CEM Header
Frurhare ’ brme -
AT ok
oos i
rrater b
Class >
YewrGroug i
Here 0 3 sarmgie from your e to heip you (hoote the appr oprate Peaders sbove
Firsthame Srrame 0o8 Ganader Class YearGroup
Arce Erapie 12102013 oo 1 1
Teri Dacryl o8N 22018 Nsie 2 2

6. At the bottom of the page, click Next' to confirm the details.

bb. Once all relevant headers have been assigned, please click "Next".

7. On the next screen, you will be given a further opportunity to edit/delete student details. Click
‘Next’ when you are happy to continue and upload these student details to the system.
Import Pupil Details for INCAS

The Sclowang 1tepn erabie you f0 emport yous pugsl detads ready 10 un the suumUTent witmare

Foit name Surname oo8 Catrder Clana Year Group

hewe Eamgie 12102015 ¥ 1 1 7 tge " Delese
Ters Dactyt o 20S U] 2 2 7 tde ™ Delete

Dory N272012 w 2 2 7 e * Delete

(=]

8. A green banner notification will display at the top of the screen to let you know you have
successfully uploaded your student details. You can also confirm this by checking the data in
the ‘Manage Pupil Details’ tab.

LA AR RN

3 pupd(s) harve been suctesshully imported

Welcome to the Assessment Centre

Plewse sedect the approprate tab sbove



Editing/adding student and class details

In the Assessment Centre you can use the ‘Manage Pupil Details’ option to edit, add, move and
delete student and class details.

Manage Pupil Details for INCAS

On this page you can add and edit pupil dezails. Use the filters 1o specify the year group or class you wish 1o view,

m Year Class

All

- A~ . - Al- .
[ new - | eom | move -] oeere

a @

edit Firsz name T | Surname v Gender Y| DOB Class v Year Group v | UPNissuden.. v

Edit student details
Select the name of the student whose details you would like to edit by clicking on the Edit button by
their name.

Click 'Save’ once you have edited the details required.

Edit Pupil

Aarar Maad

Create a new student or class
Click on ‘New' and select either ‘Pupil’ or ‘Class’.

The next box will allow you to add the required information for a new student or class. Select ‘Save’
once done.

Rl cor -] wove -] peete -
Pupil
Class

=
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Delete a student record
Click on ‘Delete’ and choose ‘Pupil’.
Put a tick next to the candidate(s) you want to delete from your current list and select ‘Delete’

m Year Class

All " - All - )
“ Pupil
2 Class
On the next screen you will be asked to confirm the deletion. You will also be alerted if the student
has any scores associated with their profile.

Delete a class record
Click on ‘Delete’ and choose ‘Class'.

m Year Class

All v - All - L]
* Pupil
Q Class
The box that appears will ask you to select the class you want to delete from the drop-down menu.
Once chosen, click ‘Delete’.

Delete Class

Choose Class to delete - select - ~

TIP: You will be asked to confirm the deletion. If there are students in the class to be deleted, you

will not be able to proceed with the deletion. If you make a deletion in error, please get in touch
with our customer service team for assistance.

1"



Move a student into a new year group/class

Select the student you want to move clicking the tick box next to the ‘Edit’ button. Select ‘Move’ and
choose either ‘Year Group’ or ‘Class’.

2 | Y | AL 6 @
-
BN S e e e

Manage Pupil Details for INCAS

On this page you can add and edit pupil details. Use the fiters to specify the year group or class you wish to view.

W Year Class
Al v [-an- -
Year Group.
| cess
edic Firstname v | Surname v Gender v oo Class v YearGroup vy UPN/suden.. y
Edit Ann Other F 2210172015 Testing Yeard

On the next screen, edit the details as required and click Save.
Move Year Group

You have selected 1 pupil(s)

You can then select where you want to transfer the student to from the drop down menu and
select ‘Move'.

Setting up the Web-based version

Accessing the Assessment Shortcut

1. Within the Assessment Centre select the ‘Carry out Assessments’ menu option.

e = el | W= R [ e M s

Welcome to the Assessment Centre

2. Next, click on the arrow in the Web-Only version box.

select assessment W manage pupildetails » ] m

Carry Out Assessments for INCAS

Please select the assessment software you would like to download.

 This version of the software * This version of the software
should be used by schools who should only be used by schools
have computers with no who have a high speed wired
internet connection. internet connection.

 For more details click ‘Non- * For more details click Web-
Web Version’ Only Version'

Non-Web Version @ Web-Only Version @

. On the next page, you can access your assessment shortcut link and passkey. The assessment
link is unique to your school, the passkey is the same for each student.
Web Delivered Assessment for INnCAS
WEB»ON{LY V’ERSION: P

ASSESSMENT SHORTCUT

Click here to download the assessment shortcut.
or

Copy and paste the text below into a shortcut.

PASS KEY FOR ASSESSMENT

For security reasons to access your assessment over the web using a browser, you will have to enter a pass key. For your assessment these are listed below.
Assessment Key

InCAS

12



Using the Assessment Shortcut URL
You can either download

i) the online assessment shortcut or

ii) create a desktop shortcut.

i) Downloading the Assessment Shortcut
1. Select ‘Click here’ to download the assessment shortcut.

Web Delivered Assessment for INCAS

WEB-ONLY VERSION

This version of the software should only be used by schools who have a high speed wired internet connection.

ASSESSMENT SHORTCUT

Click here to download the assessment shortcut.
or

Copy and paste the text below into a shortcut
htp: cem. D F78906

PASS KEY FOR ASSESSMENT

2. The shortcut will appear in the bottom left corner of your Chrome browser. You can then save it
somewhere on your school system, in a location where your students can easily access it.

@ Link (3).html A

ii) Creating a desktop shortcut

1. Highlight the shortcut text displayed beneath the ‘Click Here' link and ‘Copy'.
Web Delivered Assessment for INnCAS
WEB-ONLY VERSION
This version of the software should only be used by schools who have a high speed wired internet connection.
ASSESSMENT SHORTCUT

Click here to download the assessment shortcut.

or

Copy and paste the text below into a shortcut
https://assessments.cem.org/incas/GetSessionlD.aspx?regkey=32F78906-791

PASS KEY FOR ASSESSMENT

2. Go to your computer desktop. Right click your mouse and select ‘New’ then ‘Shortcut'.

Undo Rename Ctrl+Z
& Shared Folder Synchronization >

B3 Graphics Properties...
B Graphics Options > Folder

Mew > # Shortcut
3 Display settings 5_1] Microsoft Access Database
& Personalise & Bitmap image

- @ Contact

Or, select ‘New item’ then ‘Shortcut’.

W5 Mew item = -

Falder
New,
rol[l" [
E| Bitmap image
[B=] Contact

13



3. Paste the copied shortcut text into the location text box.

# Create Shortcut
What item would you like to create a shortcut for?

This wizard helps you to create shortcuts to local or network programs, files, folders, computers, or
Internet addresses.

Type the location of the item:

Browse...

Click Next to continue.

MNext Cancel

4. Rename your assessment link. In this example, we will rename the test link /nCAS Assessment

What item would you like to create a shortcut for?

This wizard helps you to create shortcuts to local or network programs, files, folders, computers, or
Internet addresses.

Type the location of the item:
InCAS Assessment

| | Browse...

Click Next to continue.

5. The test link will look like this on your desktop. Students can now click the icon to access the

assessment.

14



Setting up the Non-Web version

Note: You should import your student details into the Assessment Centre before downloading the
Non-Web version of InCAS. This way it will already contain student details when you download the
software.

You will need to create a folder on your computer called INCAS_2023-24. This location should be

accessible to the students doing the assessments. Note: the folder must be on a mapped drive (e.g.,
C:\ where C can be any letter) and must not be a server path or the desktop path (e.g., \\myserver).

Access the InCAS Non-Web version

1. Download and install the software by selecting the ‘Carry out Assessments’ option. Click on the
arrow in the Non-Web Version box.
Carry Out Assessments for INCAS

Please select the assessment software you would like to download.

« This version of the software « This version of the software
should be used by schools who should only be used by schools
have computers with no who have a high speed wired
internet connection. internet connection.

* For more details click ‘Non- o For more details click ‘Web-
Web Version’ Only Version’

Non-Web Version @ ‘Web-Only Version @

2. This will take you to the Non-Web page. In this guide, we will be looking at the Assessment for
Windows (Assessment for Mac is also available).

Click on the download icon.
NON-WEB VERSION

+ Download a zip file containing
all the assessment files here.

» Click here for system
requirements.

Download

* Download a zip file containing
all the assessment files here.

* Click here for system
requirements.

Download

Assessment Assessment
for windows for Mac

3. You will see the file appear as follows. You can download it by double-clicking on the file.
¢ INCAS_EW_2025_0..zip A

4. This will open the file to show the contents:

Name Type
Media File folder
Saves File folder
XML File folder
:] CEM_Font_Licensing Text Document
Lj CEM_Software_Licence Text Document
[85] InCAS_EW_2025_0001 Application

15



5. In the meantime, create a new folder on your desktop machine. This is where you can extract
your files once downloaded. In this instance, we will call it INCAS Assessment.

6. Unzip the contents of the zip file. You can extract the files by right-clicking anywhere in the
white box and selecting ‘Extract All'.

Name Type
Media File folder
Saves File folder
XML File folder
| CEM_Font_Licensing Text Document
| CEM_Software_Licence Text Document
(&) InCAS_EW_2025_0001 Application
View >
Sort by >
Group by »
Refresh
Paste

Paste shortcut

Undo Rename Ctrl+Z

Extract All...

7. You will see the screen below. Select ‘Browse’ to choose the folder created at step #5, called
INCAS Assessment. You can now click on ‘Extract’.

¥ Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder:

Desktop\InCAS Assessment Browse...

[ Show extracted files when complete

8. The extracted files will now appear. In this example, you need to double-click on the icon called
INCAS_EW _2025 001 to launch the INCAS assessment.

MName Type
Media File folder
Saves File folder
XML File folder
| CEM_Font_Licensing Text Document
_]‘ CEM_Software_Licence Text Document
(55 InCAS_EW_2025_0001 Application

In the example above, the Saves folder is where your offline results files will be stored before
transfer to CEM. The InCAS_EW _2025 001 is the assessment file.

16



9. You will see the box below when you click on the InCAS_EW_2025_0001 file:

P CEM eAssessment - X

CEM
Welcome to CEM eAssessment

Our assessments are to be run from your web
browser. We recommend our assessments be run
in Chrome or Safari. For a full list, please see:

)

1. Open a Chrome or Safari browser window

2. Copy the link below into the address bar of your
browser.

hitp Mocalhost 8085M0cal

3. Once the assessment is finished you may close
the browser window.

4. To run another assessment on this computer
simply repeat steps 1-3

5. Once all your assessments have been completed,
close this window to stop the assessment senice.

Do NOT close this window until the assessments
have been completed
10. Copy and paste the URL link at step 2 in the box above into a new browser. Select ‘Submit'.

11. When the assessment loads, the student will be asked to enter their password - see page 19 for
details of where to find the student passwords.

IMPORTANT TECHNICAL INSTRUCTIONS: Ensure staff members have ‘Modify; level of
permissions for the whole ‘InCAS_2025’ folder and sub folders.

Create a shortcut to ‘InCAS_EW_2025_001' somewhere teachers can access it from their accounts,
eg., on the desktop.

17



Accessing the Pass Key (online version)
When using the online INCAS assessment, the student will first be asked to enter the pass key..

The six-digit pass key is the same for all students and unique to your school. It can be found in the
assessment centre of your INnCAS+ account as shown.

select assessments import manage pupil details password lists ATy Out assessments status reports recurn results

Web Delivered Assessment for INnCAS

WEB-ONLY VERSION

This version of the software should only be used by schools who have a high speed wired internet connection.

ASSESSMENT SHORTCUT

Click here to download the assessment shortcut.
or

Copy and paste the text below into a shortcut. )
https://assessments.cem.org/incas/GetSession| D.aspx?regkey=32F7:

PASS KEY FOR ASSESSMENT

For security reasons to access your assessment over the web using a browser, youwill have to enter a pass key. For your assessment these are listed below.
Assessment Key

INCAS B Q -

When the assessment opens, the student should enter the pass key and click ‘Submit’
@CAMBRIDGE

USIVERDITY FRESS & ASSESSMENT

Centre for Evaluation & Monitoring

User Login

A Pass Key is required to start this assessment, Please enter it here.

FRRERY; m

18



Accessing the student passwords

Each student enters their unique three digit password at the beginning of each module.
To access the passwords go to the Assessment Centre > Password Lists

select assessments import manage pupil details password lists carry out assessments status reports return results

Welcome to the Assessment Centre

Please select the appropriate tab above.

On the next screen, you have the option to view and print off passwords.

You can also filter by ‘Year’ (year group) ‘Class’ (class name) and ‘Session’ (Subtest name) to quickly
find passwords.

m Year Class Session
-Ml- v Al w -+ w

First name ¥ Surname 4 v DOB SubrestName Password
a1
Anne Example 12125 Autitudes Quiz AKL
Anne Example 12102015 Developed Ability Quiz NG
Anne Example 1212015 General Maths Quiz i
Anne Example 12102015 Mental Arithmetic Quiz oy
Anne Example 12205 Reading Quiz VRS
Anne Example 121072015 Spelling Quiz EY0
2
Teri Dactyd 0&N22M5 Attitudes Quiz ARA
Teri Dactyl 0an2/2015 Developed Abibity Quiz VFF
Ten Dacryd 0822015 General Maths Quiz WP
Teri Dactyl 0811272015 Mental Arithmetic Quiz KET
Ten Dacryd oanLr2ms Reading Quiz 5C
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Running the Assessment

Beginning the assessment
1. When the assessment has loaded the student will see this screen.
They should click ‘Next'.
Note: For the online version, they will have been asked to enter the pass key first.

c

EM

Click or tap the Next’ button to begin.

2. The student will now be asked to enter their 3 digit password for the INCAS module they are
taking. They can then click ‘Next'.

C—

3. The student will then need to confirm their details are correct and select ‘Next'.

Before you begin, please check the following details have been entered correctly.

When you are ready to begin, click or tap the “Next" button below.

Name: Ann Other

Date of Birth: 22 January 2015

Assessment: Developed Ability Quiz

Testing Phase: Testing Period

Audio Language:  English

4. There will then be the opportunity to test the sound and volume through the headset. When
ready, the student can select ‘Start’ to begin the assessment.

Test the sound

Click or top on the button to check you can hear the sound.

[ Test Sound m ‘

You can change the volume using the slider.

L]
l Set Volume = o

Mow wait for your teacher to tell you to start the ossessment.

[t Back \ Start .: 20




Taking the assessment

Each module of the INCAS assessment will start with an example question to ensure the student is
clear about what to do. This must be answered correctly to move on to the assessment questions.

Questions typically start at an age equivalent level two years younger than the student is at the
time of taking the assessment. Questions progressively become more difficult until a few are
answered incorrectly. Questions then become slightly easier until they are being answered correctly
once more.

For this reason, students can expect to find some questions too easy and some too difficult when
taking the assessment and not all will see the same questions.

Please note the following:

Reading module

This module has three sub-sections; Word Recognition, Decoding and Comprehension. A student
will only be presented with the Comprehension section if they have scored highly enough in the
Word Recognition and Word Decoding sections. Those students who do not achieve sufficient
high Word Recognition and Word Decoding scores to access the Comprehension module during
the assessment are credited with the minimum Comprehension score in the calculation of the
composite Reading score.

Mental Arithmetic module

The four sub-sections appear in the order Addition, Subtraction, Multiplication and Division. A
student will only be presented with the Subtraction section if they have scored an Addition score
greater than 5 years. They will only be presented with the Multiplication section if they have scored
a Subtraction score greater than 7 years. Finally, a student will only be presented with the Division
section if they have scored a Multiplication score greater than 8 years.

Ending the assessment

When the module has been completed, or the time has run out, the student should see this screen.
—

You have now finished the quiz.
Your test results have been saved.
Tell your teacher you have finished.
Thank you for taking the Quiz.
Please click or tap the cross at the top of the screen to close the browser.

@ Back to Start Screen

—
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After the Assessment
Returning Data for the Web-Only Version

Unless you see an error message, the data will automatically return via INCAS+ at the end of the
assessment if you are running the Web-Only version of InCAS.

Returning data if your internet
connection drops

The student will see the error message below if there is a loss of internet connection when the
system is trying to return date for the Web-only version.

Fhease et your teacher know thal there has been a problam
saving your results

¥We have ned 1o 5ave your resulls 10 your downloads folder.
Ask your leacher 1o check thal the results have saved
comectly and to click YES If they have or NO if they have not

Warning : Clicking YES if the results have not saved o your
downicads folder may mean that your results are lost and
you will have 1o 51t the assassment again

Has your file saved comectly?

There are safeguards in place to ensure, wherever possible, the student does not need to resit a
completed module as the result of a connection failure.
The system will force the results to save to the ‘downloads’ folder of your computer device. This will
be in a CSF format.

1. Please check the CSF file has saved to the ‘downloads’ folder.

2. If saved correctly, you will see a “CEM_RESULTS_FINAL_XXXCSF” (where XXX is a long string of
numbers and letters) file appear in the bottom left-hand corner of the browser window.

Teduy
CEM_SERLTE FIMAL THIFHET-4AS 14 104-AD -4 TR TR R ool

i RN T

e

3 Saptembar 2019

g, wirsdiown_sil_s BOTI0LAT 1 DERI0-10, e

This may look slightly different in different browsers. You can also open the browser's
‘downloads’ folder and check if a result file with that name appears with a creation date/time
within the last minute or so.
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3. We recommend you copy this file immediately to a USB drive or a common server location, to
facilitate easy upload to CEM.

4. If you are satisfied the results have saved correctly, click ‘YES'.
|

Piease let your teacher know thal there has been a problem
saving your results.

We have tried 1o save your resulls to your downiloads folder.
Ask your teacher 1o check that the results have saved
comectly and to click YES If they have or NO if they have not.

Warning : Clicking YES If the results have not saved 1o your
downioads folder may mean that your results are lost and
you will have to sit the assessment again

Has your file saved comectly?

You will then see this screen, and the test will finish as normal.

T BCESS QUELIROE O PRI it B 10 CEM Dl vadl

POUF SOCLOE e

5. You can then go to ‘Return Data’ in INnCAS+ > Assessment Centre > Return Data > Upload Results
and follow the instructions to upload the saved CSF results file. See step seven on page 26 for
further details.

6. If the CSF file has NOT saved correctly in the ‘downloads’ folder, click ‘NO'.
]

Please let your teacher Know that there has beéen a problem
saving your results

We have tried to save your results to your downloads folder.
Ask your teacher to check that the results have saved
comecily and to click YES if they have or NO if they have not.

Waming : Clicking YES if the results have not saved 1o your
downloads folder may mean that your results are ost and
you will have 10 sit the assessment again.

Has your file saved comectly?
Lo

The system will attempt to save the results again. The system attempts to save the file to the
‘downloads’ folder up to five times, and the user will see the same dialog each time, assuming
they do not click ‘Yes'.
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7. If you are still unable to verify a file has saved to the ‘downloads’ folder, or you have clicked 'no’
five times, you will be taken to the copy & paste dialogue shown.

Select the ‘copy’ button and paste the contents into a Notepad (or similar) file and return it to
CEM by e-mail to cem@cambridge.org.

Cannot Save Results

Waming The program cannct save your results
automaticaly. Piease dick Copy below and paste the
Iviorrmahon Imo a2 texd Ake or 3 Rordproces o coourment
Save the Al and return e Cooumen! %0 CEM. Onoe you
ciick e Ok bution below, this window 'will ciose and the

azzezsment wil end

Tamil wersagn="1.0" enCOng="UTF-§"7>=CEM
Suppler="CEM® Type="EARSSUNS"
YO T B ARG AR CredanonDate="2019-09-
TT10 22 S(r>«CandidalaLis!
UMENICAIONASE= " Corr D™
SnAIOWed="Y" GUID="21TB1733-21A5-4489 =

g |

Returning data for the Non-Web Version

You will need to return your results to us once you have completed the Non-Web version of the
assessments with your students.
1. Go to the files you extracted as part of your download to install the Non-Web version of the
assessment on your computer.

Name Type
Media File folder
Saves File folder
XML File folder
__] CEM_Font_Licensing Text Document
3 CEM _Software_Licence Text Document
[ InCAS_EW_2025_0001 Application

2. Click on the Saves Folder below.

Name Status
Media @
Saves @
XML @
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3. You will see the files in the folder as follows:

Name . ~ Status Dite modified Type Size
12/05/202%18PM  File folder

2018PM  CEMFile 116K8
2022 5:08 PM CEM File 9KB
2022909 PM CEM File 18K
12/05/2022 %:11 PM CEM File 21KB
2022811 PM CEM File 25K8
52022 %12 PM CEM File KB
1 2022 %12 PM CEM File 3TKB
12/05/2022 9:12 PM CEM File 9B

Final

[7] 384EF203-DOCS-4BED-B23A-F518AT2FIO5C- -0l cem

[ 384EF203-DSC5-4BED- B29A-FSIBATIFIOSC--01--O.cem
[ 7] 3846F2D3-DICS-4BED- B29A-FS18AT2FIDSC--01--02.cem
[ 7] 3846F203-DSC5-4BEO-B2OA-FS1BAT2FIOSC--01-O3.cem
[7] 284EF2D3-DOCS-4BED-B29A-FS1BATFIDSC--01- D4 com
L ‘] 3B4EF203-D9C5-4BED-B29A-FS1BATFI05C--01--05.cem
] 3BEF2D3-DSC5-4BED-BI9A-FS1BAT2FI05C--01--Dbcem

:_‘| 3BAEF2D3-DOC5-4BED-BI9A-F51BATFI05C--01--0T cam
;j 3BREF2D3-DSC S18AT2FI05C--01--08. 12/05/2022 %12 PM CEM File 43 KB
[ 3B4EF2D3-DIC5-4BED-B2IA-FS1BATIFIDSC--01--09.ceom 12/05/2022 913 PM CEM File ATKB

[ 384EF2D3-DSC5-4BED-BI9A-FS1BATFIDSC--01-10.cem 225:14 PM CEM File 52 KB
[ 384EF203-D9C5-4BED-B2IA-FS1BATIFID5C--01--11.cem 22914 PM CEM File 56 KB
| '] 384EF203-DIC5-4BED-B29A-F518ATIFID5C--01--12.cem 12/05/2022 9:14 PM CEM File S9KB

[ 384EF203-DSC5-4BED-B29A-F51BATIFI0SC-01--13.cem 1 22 %:15PM CEM File B2KB
[ 384EF203-DIC5-4BED-B29A-FS18ATIFODSC--01--14.cem 12/05/20229:15 PM CEM File B4KB
| '] 384EF2D3-DIC5-4BED-B29A-FS1BATZFID5C--01--15.cem 12/05/2022 9:15 PM CEM File ETKB
[ 384EF203-DSC5-4BED-B29A-FS1BATIFIO5C--01--16.cem 12/05/2022 %15 PM CEM File T2KB

2022 :16 PM CEM File T5KE
12/05/2022 %:17 PM CEM File B4 KB
2022 1T PM CEM File KB
2022 %17 PM CEM File S KB
2022 %18 PM CEM File 105 KB
2022 %18 PM CEM File 111 KB
122 9:04 PM XML Document 1K8

[ 284EF203-DCS-4BED- B29A-FSIBATIFSDSC--01--17.cem
[7) 384EF2D3-DIC-4BED- B29A-FS18AT2FIOSC--01--1B.cem
[7] 384EF2D3-DOCS-4BED- B29A-FS18AT2FIDSC--01--19.cem
| I] 3B4EF2D3-DOCS-4BED-B29A-FS1BAT2FSD5C--01--20.com
L ‘] 3B4EF203-DIC5-4BED-B29A-FS1BAT2FI05C--01--21.cem
[ 384EF2D3-DSC5-4BED-B2IA-FS1BATIFIDSC--01--22.cem

! EACa e TectFile- 200241 21989

P00 OOPPORPREPRRIOIIOOOOOB®

4. Highlight the files by clicking on the first file at the top and then press Shift + down arrow (0)
until all the files are highlighted like the ones below.

Final @ 12/05/2022 %18 PM File folder
|_] 384EF2D3-DICS-4BED-B29A-FS1BAT2FIDSC--Ol.cem @ 12/05/2022 %18 PM CEM File 116KB
] 384EF203-DIC5-4BED-B29A-FSIBATFIDSC--01--Olcem @ 12/05/2022 9:08 PM CEM File 9KB
| ] 384EF2D3-DIC5-4BED-B29A-FSIBATZFIDSC--0)--02cem @ 12/05/2022 9:09 PM CEM File 18KB
| ] 384EF203-DIC5-4BED-B29A-FSIBAT2FIDSC--01--03cem @ 12/05/2022 %:11 PM CEM File 218
| ] 384EF203-DIC5-4BED-B29A-FSIBAT2FIDSC--01--Odcem @ 12/05/2022 9:11 PM CEM File 5KB
u 3B4EF2D3-D9C5-4BED-B29A-F51BAT2FI05C--01--05.cem. (=] 12/05/2022 %12 PM CEM File 31KB
|| 3B4EF2D3-DICS-4BED-B29A-FSIBATIFIDSC--01-Dbcem @ 12/05/2022 9:12 PM CEM File 37 KB
] 384EF203-DICS-4BED-B29A-FSIBATZFIDSC--01--0lcem @ 12/05/2022 %12 PM CEM File 39 KB
| ] 384EF203-DICS-4BED-B29A-FSIBATZFIDSC--01--0Bcem @ 12/05/2022 %12 PM CEM File 43 KB
] 384EF2D3-DIC5-4BED-B29A-FSIBATZFIDSC--01--09.cem @ 12/05/2022 %13 PM CEM File 4TKB
| ] 384EF203-DIC5-4BED-B29A-FSIBAT2FIDSC--01--10cem @ 12/05/2022 %:14 PM CEM File 52 KB
] 384EF203-DIC5-4BED-B29A-FSIBAT2FIDSC--O0--Tlcem @ 12/05/2022 %:14 PM CEM File 56 KB
|_] 38B4EF2D3-DIC5-4BED-B29A-F51BAT2FIDSC--01--12.cem @ 12/05/2022 %14 PM CEM File 59 KB
] 384EF2D3-DIC5-4BED-B20A-FSIBATIFIDSC--O--13cem @ 12/05/2022 %:15 PM CEM File 62KB
] 384EF2D3-DICS-4BED-B20A-FSIBAT2FIDSC--O0--14cem @ 12/05/2022 %15 PM CEM File B4KB
] 384EF2D3-DICS-4BED-B29A-FSIBATIFIDSC--O01--15.cem @ 12/05/2022 %15 PM CEM File 67KE
| ] 384EF203-DIC5-4BEO-B20A-FSIBAT2FIDSC--O1-- 16.cem @ 12/05/2022 9:15 PM CEM File T2K8
7] 384EF203-DIC5-4BED-B29A-FSIBAT2FIDSC--O01--1cem @ 12/05/2022 %:16 PM CEM File 75 KB
|_] 384EF2D3-DIC5-4BED-B2OA-FSIBATIFIDSC--O--10cem @ 12/05/2022 %17 PM CEM File KB
| ] 384EF2D3-DIC5-4BED-B20A-FSIBATIFIDSC--01--10cem @ 12/05/2022 %17 PM CEM File KB
] 384EF2D3-DICS-4BED-B20A-FSIBAT2FIDSC--01--20cem  © 12/05/2022 9:17 PM CEM File % KB
] 384EF2D3-DIC5-4BED-B29A-FSIBATIFIDSC--01--21.cem @ 12/05/2022 %:18 PM CEM File 105 K8
[ ] 384EF203-D9C5-4BED-B20A-FSIBATFIDSC--01--2.0em @ 12/05/2022 9:18 PM CEM File 111 KB
= TestFi 1989 [] 12/05/2022 %:04 PM XML Document 1K8

5. Hover over the selected files and right click the mouse. Choose Send to > Compressed (zipped)
folder.

L Final Pin to Quick access 12/05/2022 5:18 PM File folder
|_] 384€F2D3-D9C5-4BEO-B29 12/05/2022 5:18 PM CEM File 116 KB
[} 384eF2D3-DoC5-4BE0-B2q B Abways keep on this device 12/05/2022 5:08 PM CEM File 9KB
0 384EF203-DIC5-4BE0-829 Freeup space 12/05/2022 5:09 PM CEM File 18 KB
|z > | 1270572022 211PM CEM File 21KE
CRC SHA > | 1270572022 9:11PM CEM File 25KB
= 12/05/2022 5:12 PM CEM File 1N KB
Srcocxemto : > | onsaeasizem  cemFie 37K8
e Sopes o 12/052022512PM  CEMFile 39K8
Send to >| O Bluetooth device 43K
Cut | Compressed (zipped) folder 4TKB
| Copy I Desktop (create shorteut) s2kB
| ] 384F203-DOCS-48E0-829 R 56 KB
[) 3s4er203-Docs-4pE0-629  Create shortcut 5 Fax recipient 59 KB
|] 384€F2D3-D3C5-4E0-B29  Delete 21 il recipient 62KB
|| 384EF2D3-D9C5-48E0-B29 Rename ar 54KB
i = st i

=x gs5-PHLS (\\ad.cambridge.org) (P:)

|| 384EF2D3-DOCS-4BED-B2OA-FSIBATIFIDSC--01--17cem @ TS KB
| ] 384EF2D3-DICS-4BE0-B29A-FSIBATFIDSC--01--18cem @ 12/05/2022 %:17 PM CEM File B4KB
|| 384EF2D3-DIC5-4BED-B29A-FS18AT2FID5C--01--19.cem @ 12/05/2022 %17 PM CEM File 90 KB
|_] 384EF2D3-DICS-4BED-B2OA-FSIBATFIDSC--01--20cem @ 12/05/2022 %17 PM CEM File 9 KB
) 3B4EF2D3-DIC5-4BED-B2OA-FS1BATIFIDSC--01--21cem @ 12/05/2022 5:18 PM CEM File 105KB
| ] 3846F2D3.DICS-4BE0-B2OA-FSIBATIFIDSC--01--22.com @ 12/05/2022 %:18 PM CEM File 11KB
=) EASaveTestFile-202241221446430321589 ] 12/05/2022 6:04 PM XML Document 168
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6. The file will be saved at the bottom. This is the file you will need to upload in INCAS+.

Name Status Date modified Type Size
Final ] 12/05/2022 218 PM File folder
| ] 384EF203-DHC5-4BE0-B20A-FS13ATZFID5C--01.cem @ 12/05/2022 918 PM CEM File 116KB
j 3B4EF203-DIC5-4BED-B29A-FS13AT2FAD5C--01--01.cem @ 12/05/2022 9:08 PM CEM File 9KB
(] 384EF2D3-DICS-4BED-BISA-FS1ATIFIDSC-01--02 cem =] 12/06/2022 3:09 PM CEM File 18KB
|| 384EF2D3-DICS-4BED-B2OA-FSI18ATZFIDSC--01--03.cem @ 12/05/2022 11 PM CEM File 2168
:I 324EF203-DIC5-4BE-B2GA-FS13ATZFOD5C--01--04.cem @ 12/05/2022 311 PM CEM File 25KB
[ 384EF203-DIC5-4BE0-B29A-FS13AT2FIDSC--01--05.cem [=] 12/05/2022 12 PM CEM File KB
] 3B4EF2D3-DICS-4BED-B29A-FSTRAT2FIDSC--01--06, cem @ 12/05/2022 %12 PM CEM File KB
j 384EF203-DIC5-4BED-B29A-FS18ATZFIDSC--01--07.cem @ 12/05/2022 312 PM CEM File 39KB
|| 384EF203-DIC5-4BE0-B29A-F518ATZFHD5C--01--08.cem @ 12/05/2022 %12 PM CEM File 4368
j 3B4EF2D3-DICS-4BED-B2GA-FS13AT2FAD5C--01--09.cem @ 12/05/2022 213 PM CEM File ATKB
_j 3B4EF203-D9C5-4BED-B29A-FS12ATZFIDSC--01--10.cem =] 12/06/2022 214 PM CEM File S2KB
|| 384EF2D3-DICS-4BED-BOA-FSIRATZFIDSC--01--11.cem @ 12/05/2022 %14 PM CEM File S5KB
j 3B4EF203-DIC5-4BED-B29A-FS18AT2FAD5C--01--12.cem @ 12/05/2022 314 PM CEM File 59KB
[ 38B4EF2D3-DSC5-4BED-BIOA-FSI10ATIFIDSC--01-+13.cem =] 12/05/2022 15 PM CEM File 62KB
] 3B4EF2D3-DICS-4BED-B29A-FS18AT2FAD5C--01-- 1d.cem @ 12/05/2022 315 PM CEM File KB
j 3B4EF203-DIC5-4BE-B29A-FS18AT2FSD5C--01--15.cem @ 12/05/2022 215 PM CEM File ETEB
| ] 384EF203-D9C5-4BE0-B29A-FS13AT2FIDSC--01-- 16.cem @ 12/05/2022 %15 PM CEM File T2KB
j 3B4EF2D3-DICS-4BED-B2GA-FS18AT2FID5C--01--1T.cem @ 12/05/2022 216 PM CEM File T5KB
_j 3B4EF203-D9C5-4BE0-B29A-FS12ATZFIDSC--01--18.cem =] 12/05/2022 1T PM CEM File B4KB
] 384EF2D3-DICS-4BED-B2SA-FSIATIFIDSC--01--19.cem @ 12/05/2022 17 PM CEM File S0KB
j 3B4EF203-DIC5-4BED-B29A-FS13AT2FAD5C--01--20.cem @ 12/05/2022 21T PM CEM File %6 KB
[ 3B4EF2D3-DSC5-4BED-B29A-FS18AT2FIDSC -01--21.cem =] 12/05/2022 18 PM CEM File 105 K8
] 384EF203-DICS-4BED-B29A-FSISAT2FIDSC--01--22.cem =] 12/05/2022 9:18 PM CEM File 1MKB
= EASaveTestFile-202241221446430321589 @ 12/05/2022 3:04 PM XML Document 1KB
§ Final @ 12/05/2022 %57 PM Compressed (zipp... 1129 KB

7. In InCAS+, use Return Data> Upload Results to return your InCAS results file.

+ CEM
‘-'/“' Centre for Evaluation & Monitoring

Administration

f‘- Centre for Evaluation & Monitoring

Administration Return Data Results/Analysi d: Help

Upload Results

This page should be used to return your assessment data only if you are using the Non-Web version of
the software or where the web connection failed when using the Web-Only version during
automatic return of data.

Instructions on how to create the file for upload can be found in the FAQ section.
To upload the file:

= Click on the "Browse" button below (this button is labelled "Choose File” on some browsers)
= Find the folder with the zip file that you created and saved from the InCAS software

« Select the most recent file you have saved and click "Open”

» Click "Upload”

No file chosen

9. You will receive a confirmation message when the file has uploaded successfully.

1 filefs) has been uploaded successfully

Return Results

This page should be used to return your assessmeent data for the Non-Web Version of the where the fall g dutomatic
retum of data (nstructions on how to create the file for upload can be found in the FAQ section).




Status Reports

You can see which modules have yet to be completed by checking the Status Reports within the

Assessment Centre.

]

select assessments

The next screen will display as follows:

Status Report for INnCAS

This page shows a summary of the status of your assessments.

oD e

All- v

Class
-All-

o @

Forename vy | Surmame vy DOB

4 Year 4 Testing
Other

Ann 22/01/2015

Hana Test Kelly 24/10/2017

+ Year 4 Year 4-1

¥ Reading...

Pending

Pending

¥ General...

Pending Pending

Pending Pending

v  Develop...

import manage pupil details password lists carry out assessments status reports return results

v | Mental A...

Pending Pending

In Progress
30/11/2022
133

Pending

v | Spelling ...

v Attitudes... v

Pending

In Progress
30/11/2022
13:30

For every student loaded to the system, each module will have one of the statuses below:

* Pending - the module has not yet been taken

+ Completed - the module has been successfully completed

* In-Progress - the module has been started but not finished

Assessment Feedback

Assessment feedback is available within 48 hours of a completed assessment. To access, return
to the INCAS home page and choose ‘Results/Analysis’. You can then choose your reports from the
dropdown menu.

N/
IAX

C E I I Centre for Evaluation & Monitoring

Administration Return Data Results/Analysis Downloads Help
Standard Feedback
Custom Feedback L
CLICK HERE FOR AN s ATE CONCEF
— Age Comparisen
TRANSMISSION OF Ol charts YOU.
Age Standardised
Scores
New 100K, IT . ereciceon
We're really excited to be ab  Pupil Progress Chart
share what being part of Ca
Download results
means to you and your scha e
|- — —
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FAQs

l. 1 have a spinning hourglass display after the sound test screen and
the assessment won't load. How do | resolve this?

To give a little background, the spinning hourglass would suggest the system is still trying to
download the content. The sound files and audio files in the CEM assessments can take up a lot of
your internet bandwidth. Typically, a school will have a bandwidth of 500mb, yet the audio files for
the INCAS General Maths module are approximately 45Mb per student. This explains why a delay is
possible, particularly if assessing a large group of students at the same time.
There are two potential solutions:
1. Stagger the start of the assessment, with smaller groups of students starting a few minutes
after one another. This will ease the pressure on your internet and usually solves the problem.
OR
2. Run the non-web only of the assessment. This would easily allow all students to sit the
assessment, at the same time, on the same day with no delays.

You would need to download the assessment software onto your school computer system and save
the completed tests on your computer systems. On completion of the assessment, you will need to
return the files for each student as a manual upload.

2. My student is showing as ‘completed’ in the status reports for

a particular module, but their scores are still not available in the
reports. Why is this?

It can take up to 48 hours for student scores to come through to the reports. If student scores are
still not showing after this period, please contact us over email or phone as follows:

Email: cem@cambridge.org

Telephone: +44 (0) 1223 790122

3. I know that my student(s) completed their assessment, but their
status is showing as ‘In Progress’ why is this?
The two main reasons are below:

1. ‘In Progress’ usually means the student started but did not finish the INCAS assessment module.
Therefore, the student may have an ‘In Progress’ status if they failed to end the assessment
correctly. They should only shut down the assessment at the end of the module when they
have seen this screen:

7

You have now finished the quiz.
Your test results have been saved.
Tell your teacher you have finished.
Thank you for taking the Quiz.
Please click or tap the cross at the top of the screen to close the browser.

& Back to Start Screen
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OR

2. Alternatively, the status might reset from ‘Completed’ to ‘In Progress’ if the student logs into the
module for a second time. In this instance, the student will erase their original score because
the system thinks they attempted to retake the module and did not finish it. Please provide
us with the names of the student(s) if you know that they logged into their INCAS module for a
second time. We can then retrieve the original score(s).

Your student(s) will need to start the INnCAS module from the beginning if they are showing as ‘In
Progress’, unless you can establish that they logged into the module for a second time or received
the error message shown on Page 22 of this guide.

4. There are six modules to the entire assessment, is there a set order
in which to run them and do we have to do them all?

There is no set order in which you should run the InCAS assessments. You may prefer to run the
‘Attitudes’ module first as it is the shortest and allows the students to try out taking the assessment.

By using all six INCAS assessment modules you will get the maximum benefit and value for money
from InCAS. It is at your discretion to use just some of the modules if you prefer. However, the price
will be the same as if the assessment is sold as a package.

INCAS feedback provides a detailed breakdown of the abilities of a student in the assessment
modules. This will allow schools to identify areas where additional support may be required. By
using all the INCAS modules your school will receive the most detailed student ability that InCAS can
provide.

If not using the Spelling, Mental Arithmetic and Attitudes modules please bear in mind the
following:

The Spelling module result is reported as part of the Reading module breakdown.

The Mental Arithmetic module is made up of addition, subtraction, multiplication and
division questions. The report from this module will detail the students achieved age
equivalence in each area. A student will be presented with questions in all areas if they
achieve the required age equivalence in the previous question area. For example an age
equivalence of 7 in the subtraction questions is required to be presented with multiplication
questions. This will highlight any areas where a student has struggled and works well
alongside the results from the General Maths module.

The Attitudes module looks to record the student’s attitude to Reading, Maths and School.
This can provide an interesting complement to the student results in the Reading and Maths
assessment modules.
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